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Before You Begin
Overview
RISASection is a general-purpose built-up section properties calculator program. This program has been developed to
make the definition and calculation of built up sections as fast and easy as possible.
The sections that you create will be made up of individual basic shapes. You may double-click or drag-and-drop these
shapes from the shape library onto the workspace where you build the overall section. You may then use the drawing
grid to reposition and resize the basic shapes to achieve the desired cross section. Alternatively, you may import a more
complicated shape directly from your DXF file and then build upon it, or use it to import into RISA-2D, RISA-3D, or
RISAFloor for design in your analysis model.
The properties of the section may be continuously updated as you edit and refine your section. Once you are satisfied
with your section, you may build a report for printing.

Hardware Requirements
Minimum
l
l
l
l
l
l

Any Windows compatible computer with a Pentium 3 or better processor
Windows XP\Vista\Windows 7
256 MB of RAM
200 MB of hard disk space
Two or three button mouse
USB port (required for Stand-Alone version or the Network Host computer)

Recommended
l
l
l
l

Windows XP\Vista\Windows 7
As much extended RAM as possible
As much free disk space as possible
Two button mouse with wheel

Note
l

The amount of space needed by RISASection to solve a particular structural model depends on the size of the
file. RISASection has been written such that it will use as much RAM as is available. If this isn't enough,
RISASection will start using hard drive space until enough memory is obtained to solve the problem. Of
course, if RISASection is required to use hard drive space, the solution will be much slower. So, the more
memory you have available, the better.

License Agreement
END-USER LICENSE AGREEMENT FOR RISA TECHNOLOGIES, LLC® SOFTWARE
The RISASection software product (SOFTWARE PRODUCT) includes computer software, the associated media, any
printed materials, and any electronic documentation. By installing, copying or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this agreement. If you do not agree with the terms of this agreement RISA
Technologies, LLC is unwilling to license the SOFTWARE PRODUCT to you. In such event you must delete any installations and destroy any copies of the SOFTWARE PRODUCT and return the SOFTWARE PRODUCT to RISA Technologies, LLC within 60 days of purchase for a full refund.
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Copyright 2012 by RISA Technologies, LLC. All rights reserved. The SOFTWARE PRODUCT is protected by United
States copyright laws and various international treaties. All rights not specifically granted under this agreement are
reserved by RISA Technologies, LLC.
1. SOFTWARE LICENSE. The SOFTWARE PRODUCT is licensed, not sold. All right, title and interest is and
remains vested in RISA Technologies, LLC. You may not rent, lease, or lend the SOFTWARE PRODUCT. You are specifically granted a license to the use of this program on no more than one CPU at any given time. The Network Version
of the SOFTWARE PRODUCT is licensed for simultaneous use on a certain maximum number of network stations that
varies on a per license basis. As part of the license to use the SOFTWARE PRODUCT, the program user acknowledges
the reading, understanding and acceptance of all terms of this agreement. The SOFTWARE PRODUCT may not be
reviewed, compared or evaluated in any manner in any publication without expressed written consent of RISA Technologies, LLC. You may not disassemble, decompile, reverse engineer or modify in any way the SOFTWARE PRODUCT. If the SOFTWARE PRODUCT was purchased at a discounted price for educational purposes it may in no event be
used for professional design purposes. The terms of this license agreement are binding in perpetuity.
2. DISCLAIMER. We intend that the information contained in the SOFTWARE PRODUCT be accurate and reliable,
but it is entirely the responsibility of the program user to verify the accuracy and applicability of any results obtained
from the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is intended for use by professional engineers and architects who possess an understanding of structural mechanics. In no event will RISA Technologies or its officers be liable
to anyone for any damages, including any lost profits, lost savings or lost data. In no event will RISA Technologies,
LLC or its officers be liable for incidental, special, punitive or consequential damages or professional malpractice arising
out of or in connection with the usage of the SOFTWARE PRODUCT, even if RISA Technologies, LLC or its officers
have been advised of or should be aware of the possibility of such damages. RISA Technologies, LLC entire liability
shall be limited to the purchase price of the SOFTWARE PRODUCT.
3. LIMITED WARRANTY. RISA Technologies, LLC warrants that the SOFTWARE PRODUCT will operate but does
not warrant that the SOFTWARE PRODUCT will operate error free or without interruption. RISA Technologies, LLC
sole obligation and your exclusive remedy under this warranty will be to receive software support from RISA Technologies, LLC via telephone, email or fax. RISA Technologies, LLC shall only be obligated to provide support for the
most recent version of the SOFTWARE PRODUCT. If your version of the SOFTWARE PRODUCT is not the most
recent version RISA Technologies, LLC shall have no obligation to provide support in any form. Except as stated above
the SOFTWARE PRODUCT is provided without warranty, express or implied, including without limitation the implied
warranties of merchantability and fitness for a particular purpose.
4. PROTECTION DEVICE. In the event the SOFTWARE PRODUCT requires the use of a PROTECTION DEVICE to
operate, you are specifically prohibited from attempting to bypass the functionality of the PROTECTION DEVICE by
any means. If the PROTECTION DEVICE becomes broken or inoperable it should be returned to RISA Technologies,
LLC for a replacement. The replacement will not be provided if RISA Technologies, LLC can not affirm that the broken
PROTECTION DEVICE was originally provided by RISA Technologies, LLC for use with the SOFTWARE PRODUCT.
A lost or stolen PROTECTION DEVICE will not be replaced by RISA Technologies, LLC.
5. TERMINATION. RISA Technologies, LLC may terminate your right to use the SOFTWARE PRODUCT if you fail
to comply with the terms and conditions of this agreement. In such event you must delete any installations and destroy
any copies of the SOFTWARE PRODUCT and promptly return the SOFTWARE PRODUCT to RISA Technologies,
LLC.
6. CHOICE OF LAW. By entering into this Agreement in accordance with Paragraph 1, above, you have agreed to the
exclusive jurisdiction of the State and Federal courts of the State of California, USA for resolution of any dispute you
have relating to the SOFTWARE PRODUCT or related goods and services provided by RISA Technologies, LLC. All
disputes therefore shall be resolved in accordance with the laws of the State of California, USA and all parties to this
Agreement expressly agree to exclusive jurisdiction within the State of California, USA. No choice of law rules of any
jurisdiction apply.
"RISA" as applied to structural engineering software is a trademark of RISA Technologies, LLC.
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Technical Support
Complete program support is available to registered owners of RISASection and is included in the purchase price. This
support is provided for the life of the program. See Technical Support for a list of your support options.
The “life of the program” is defined as the time period for which that version of the program is the current version. In
other words, whenever a new version of RISASection is released, the life of the previous version is considered to be
ended.
RISA Technologies will support only the current version of RISASection.

Installation
To install RISASection please follow these instructions:
1. Put the RISASection CD in your computer CD drive.
2. If the CD starts automatically go to step 4. If the CD does not start after 10 seconds click the Windows Start button and select Run.
3. In the Run dialog box type “d:\launch” (where “d” is the label of your CD drive) and then click the OK button.
4. Follow the on-screen instructions.
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Overview
How it Works
The sections that you create will be made up of basic shapes. You may double-click or drag-and-drop these shapes from
the shape library to the workspace where you build the overall section. Working on the optional drawing grid you may
reposition and resize the basic shapes to achieve the desired cross section.
The properties of the section may be continuously updated as you edit and refine your section. Once you have completed the section you may build a report for printing or save the file for future use in RISASection or for importing by
RISA-2D, RISA-3D, and RISAFloor.

Some Basic Terms and Notations
l

l
l
l

A Shape is the basic component that can be used to create Sections. The properties of an individual Shape can be
determined and its dimensions can be modified. New Shapes can be created and predefined Shapes from standard
libraries can also be used and modified.
A Shape Library is an area on the program interface where standard Shapes can be obtained.
A Section is a combination or collection of Shapes placed together to act as a single cross-section.
A Property Multiplier is used to specify the relative weight of the Shape in the over all Section. Generally, it is
the ratio of the Modulus of Elasticity of a particular shape and the Base Modulus of Elasticity (you can adjust
this in the Section Properties tab of the Options menu). However, any positive, negative or zero value may be
specified.

Section File Names
Sections are saved in files with a .nmsx extension by default. Multiple sections may be created and saved in one file, so
you could have a file called STEEL.nmsx and one called CONCRETE.nmsx that store your steel and concrete shapes separately. You might name your files by project instead. That is completely up to you. All sections in a file are saved
together by clicking
just once.
RISA-3D, RISAFloor, and RISA-2D look for all .nmsx files in the directory specified under Tools - Preferences- File
Locations tab and simultaneously provide a list of all sections that exist in any of the .nmsx files. You can see which
sections are available by clicking on the shape database within RISA-3D, RISAFloor, or RISA-2D.Then click on the General tab or the Hot Rolled tab (depending on which Material you selected in RISASection). Under Database/Manufacturer you can select RISASection. You will then be able to see the sections available to you. The list
provided is of the names of the sections within each section file, so it is important to use unique, descriptive names for
each section you create.

Interaction with RISA-3D, RISA-2D, and RISAFloor
RISA-3D, RISA-2D, and RISAFloor look for all .nmsx files in the directory specified under Tools -Preferences -File
Locations tab and simultaneously provides a list of all sections that exist in any of the .nmsx files. You can see which
sections are available by clicking on the Shape Database button
within RISA-3D, RISA-2D, or RISAFloor. Shapes
that are designated as Hot Rolled Steel Material Type in RISASection will be found in the Hot Rolled tab of the Shape
Database under the RISASection Database/Manufacturer.
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Shapes that are designated as General Material Type in RISASection will be found on the General tab under the RISASection Database/Manufacturer.
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For additional advice on this topic, please see the RISA News website: www.risanews.com. Type in Search keywords:
RISASection Integration.

Computation of Properties
Closed Shapes
The geometric properties are computed with the Polygon method. All closed shapes are represented by closed polygons.
Curvilinear and circular shapes or edges are represented by several straight line segments. The properties of the overall
shape are computed by geometric summation of the properties.
Accuracy of the Polygon Method
The above method for computation of geometric properties is generally adequate for shapes of usual dimensions and proportions. The method may lose some of it accuracy for very oblong shapes, highly curvilinear shapes and for shapes with
very small or very large dimensions. These errors are introduced due to numerical round-off and may be more pronounced in the results of for second moment of area. Every closed shape is defined by a set of lines and its properties can
be calculated by combining the properties of the component individual lines.

Plastic Modulus
An iterative procedure is used to compute the plastic section modulus. The location of a "neutral axis" is determined that
weighted areas above and below this line are equal. The plastic modulus is then computed as the moments of area about
this neutral axis.

Torsion Constant J
For all general shapes, besides circles and pipes, a full finite element solution of the torsional stress distribution is used.
The section is meshed with finite elements and solved to determine J. For circles and pipes, the exact formula for torsional constant J is used.
When a section is designated as a pre-defined Hot Rolled shape type, additional torsional properties (i.e. Cw, Wno, Sw,
etc.) are calculated in order for the shape to be exported for design code checks in RISA-3D, RISAFloor, or RISA-2D.
These properties calculated using the approximate formulas from Formulas for Stress, Strain, and Structural Matrices by
Walter D. Pilkey. This is done to save in solution time and to match as accurately as possible with hand calculation
methods.
Note: These approximate formulas used to calculate Cw, Wno, etc. depend on the Flange Thickness and Web Thickness
values. This means that if your shape is far from the pre-defined shape type, or if the orientation is different than the
default, the thickness values can be calculated very wrong. Since the program cannot guarantee these values, we make
them editable for the user. Simply highlight the value in the Properties window and type in another value. If you are
changing these, it is important to also uncheck the Auto buttons associated with them because you will need to click the
Solve button once more to recalculate the torsional properties with these values.
Thin Walled Assumption
Most of the approximate formulas used to calculate the torsional properties are also dependent on the assumption that
the section applies to thin-walled theory. To check this, RISASection internally checks that:

If the section does not meet this limit, you will be presented with a Warning Message at solution.
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Built-up and Composite Sections
The properties of a built-up or composite section are computed by weighted summation and transformation of individual
shape properties to the section centroid. The weight of the shapes is based on the relative ratio of the modulus of elasticity of individual shape to that of the base material.
For additional advice on this topic, please see the RISA News website: www.risanews.com. Type in Search keyword:
Composite.
A Property Multiplier is used to specify the relative weight of the shape's Modulus of Elasticity in the overall section.
It is the ratio of the Modulus of Elasticity of a particular shape to the Base Modulus of Elasticity (which may be edited
in the Section Properties tab of the Options menu). This factor may be assigned a fixed value for each shape, or it may
be computed automatically by the program as the ratio of the Modulus of Elasticity of the shape material and that of the
Base Material.
Any positive, negative or zero value may be specified:
1 or a positive value = Solid or positive Shape
0 = Ignore the Shape in properties calculations
-1 or a -negative value = Void or hole or a negative Shape
Note that when using a negative value for a hole you want to make sure that the negative property value that use is negative of the property multiplier that you are putting your hole onto. For example, if you steel is your material and you
are punching a hole into solid section, you want your modulus of elasticity for your steel to be 29000 ksi and the modulus of elasticity for your hole to be -29000 ksi.
For additional advice on this topic, please see the RISA News website: www.risanews.com. Type in Search keywords:
RISASection Void.
You may specify the property multiplier in one of two ways. Double-click a shape, in the workspace to open the editor
and specify the modulus of elasticity and we will modify the property multiplier accordingly. Alternatively, click
to
view the layout of all shapes currently in the section. The table also shows the multiplier for each shape, which you can
modify manually.

Section Properties
The calculated Section Properties (described below) are listed on the lower right window. With the View Options on the
Option menu you may have properties calculated automatically as you build and edit a section or manually by clicking
. Click
to calculate the torsional constant J, which may not be calculated automatically. You may print the properties for the current section by clicking
or create a report that contains multiple sections.
You may calculate transformed properties for composite sections that have shapes of different materials. To do this use
the property multiplier to distinguish between the different material types.

Note:
l

There are some properties (Flange and Web Thickness, Flange Width, Shear Center) whose values are dependent
on the shape's orientation. For example, the internal calculation for the Flange Thickness of a Wide Flange shape
assumes that the shape is oriented in its default position:
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Basic Calculated Properties
These properties are calculated for all shapes, regardless of Material or Shape Type.

Property Label

Description

Total Width and Height

Total overall width and height of the section.

Centroid, Xo

Horizontal distance from the global X-axis origin to the centroid of the section.

Centroid, Yo

Vertical distance from the global Y-axis origin to the centroid of the section.

X-bar (Right and Left)

Distance from the centroid of the section to the extreme right and left fiber.

Y-bar (Top and Bot)

Distance from the centroid of the section to the extreme top and bottom fiber.

Area, Ax

Total area of the section.

Inertia, Ixx and Iyy

Moment of inertia about the global X and Y axes.

Inertia, Ixy

Polar moment of inertia.

Torsional J

Torsion constant.

Sx (Top and Bot)

Elastic section modulus of the extreme top and bottom fibers.

Sy (Left and Right)

Elastic section modulus of the extreme left and right fibers.

rx and ry

Radius of gyration about x and y.

Plastic Zx and Zy

Plastic section modulus about x and y.

Additional Calculated Properties
In addition to the properties above, the following properties may also be calculated. Their inclusion depends on the
Material and Shape Type selection in the Section Information window.

Property Label

Description

Max Thick

Maximum thickness of the section.

Flange Thick

Thickness of the flange.

Web Thickness

Thickness of the web.

Leg Thickness

Thickness of the leg of a single angle.

Space

Space in between the back to back legs of a double angle.
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Thickness

Wall thickness (such as for a tube or pipe section).

As-xx Def

Shear deformation factor about the xx axis.

As-yy Def

Shear deformation factor about the yy axis.

As-xx Stress

Shear stress factor about the xx axis.

As-yy Stress

Shear stress factor about the yy axis.

Shear Center, Xs

Horizontal distance from the global X-axis origin to the shear center.

Shear Center, YS

Vertical distance from the global Y-axis origin to the shear center.

eo

Distance from the outside web of a channel to the shear center.

ro

Polar radius of gyration about the shear center.

rT

Radius of gyration of a portion of the section including the upper flange
plus 1/3 of the web area, taken about the X axis.

rZ

Radious of gyration about the Z axis (principal axes for single angles).

Cw

Warping constant for the section.

Wno

Normalized warping function at a point on the flange edge.

Sw

Warping statical moment.

Qf

Statical moment of the flange.

Qw

Statical moment of the cross section.

Total Width (Top)

Tapered wide flange top flange width.

Total Width (Bot)

Tapered wide flange bottom flange width.

Flange Thick (Top)

Tapered wide flange top flange thickness.

Flange Thick (Bot)

Tapered wide flange bottom flange thickness.

Auto Resolve Options
Some of the additional calculated Properties offer a Auto checkbox in the Properties window.
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This checkbox controls which of the editable properties will be determined automatically per the shape graphic. RISASection will attempt to calculate these values upon solution, but because they are not always exact, you have the ability
to overwrite the RISASection value with your own. Simply click on the value in the Properties window to highlight the
entry and then type in your value.
The Auto checkbox controls whether or not these values will be re-populated if you click the Solve
button after overwriting these values. Please see the Editable Properties topic for a description of how RISASection approximates these
values.

10

RISASection V2.0

Application Interface

Application Interface
The features that are available to you in RISASection may be accessed through the main menu, shortcut menus, toolbars,
and shortcut keystrokes. You may use any or all of these vehicles to interact with the software. The main menu has the
advantage of containing all of the program options and features and may initially be the simplest to use, letting you
learn just one system. The toolbars contain more common options and invoke with one click. The shortcut menus present
options relevant to the task at hand. The shortcut keys provide a fast way to access features should you use the program
often enough to make them familiar to you. All of these features are discussed in the sections below. There are many
ways to access features and the method that you will use will simply be a matter of personal preference. The good news
is that you have the options.

Title Bar
The bar along the top of the screen is called the title bar, which displays the name of the file that is currently open. The
three buttons
on the far right side of the title bar are used to control the main window. The left button will
shrink the main application window to a button on the task bar. The middle button will shrink or maximize the window
on your screen. The right button will close the window, prompting you to save changes if necessary. You will also see
these buttons in other windows and they have the same functions there as well.
The actual work that you do will be in the main area on the screen, which is called the workspace. When you open a
model view, spreadsheet, or a dialog, it will be opened in the workspace and listed in the Window menu. You may have
as many windows open as you like.

Main Menu
All of the program features may be accessed through the main menu toolbar at the top of the screen, beginning with File
on the far left and ending with Help on the far right. Clicking on each of these menus (listed below) will display submenus that contain options that you may choose from. You may also select the main menus by using the ALT key along
with the underlined letter in the menu you wish to choose. You may then continue to use the keyboard to choose from
the menu options. In addition, some of the menu options will have hot key combinations listed to the right of the
option. These hot keys allow you to use the keyboard to access features without using the menu system.

File Menu
New Section File will close the current file, prompting for saving if necessary, and will open a new file.
Open Section File will close the current file, prompting for saving if necessary, and will open an existing file.
Save Section File will save the current file, prompting for a name if necessary.
Save Section File As... will save the current file, prompting for a name.
Import DXF File will prompt the user to select the DXF file to import.
Export will allow the user to save the file as a Legacy .nms (old file format) file.
Project Information will allow you to enter information such as project name, job number, company name, designer
name, and any additional remarks. It will put this information as a header on the pages of your reports.
Print Current Section will access RISASection printing options.
Page Setup... will access RISASection printing options.
Exit will close RISASection, prompting for saving if necessary.
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Edit Menu
Undo will undo the last edit that was applied to the model, whether it was made graphically or in the spreadsheets. You
may continue to apply Undo to remove up to 100 model edits.
Redo will reverse the last undo that was applied to the model. You may continue to apply Redo to remove up to 100
undo operations.
Cut will remove the selected spreadsheet cells or model view from the active window, but it will copy (see below) them
to the clipboard so you can paste them elsewhere.
Copy will copy the selected spreadsheet cells or model view from the active window to the clipboard.
Paste will paste data from the clipboard to the spreadsheet cells.
Select All will select the entire model.
Delete Selected Shapes will delete the selected portion of the model.

Section Menu
Add New Section to File creates a new (blank) section in the file.
Rename Section prompts for a new name of the current section.
Remove Section from File deletes the current section from the file.
Shape Layout lets you view and edit the labels, positions, and multipliers for each individual shape in the section.
Edit Current Shape lets you view and edit the labels, dimensions, and the modulus of elasticity of the currently selected
shape in the workspace.
Show Dimensions toggles the dimensions in the workspace on and off.
Rotate and Flip provides tools to move selected shapes relative to their local axes.
Align and Stack provides tools to move selected shapes relative to other selected shapes.
Merge Shapes lets you merge together individual shapes into one section. This can ensure that you get an appropriate
calculation of Torsional J.
Explode Shapes lets you explode a previously merged section back to the original individual shapes.
Add to Report adds the current view of the section to your report.

Results Menu
Compute General Properties computes all properties except for the torsional constant J.
Compute Torsional Constant J computes the torsional constant J.
Report Creation Wizard builds reports for printing.
Preview Current Report shows the current report on the screen.
Print Current Report prints the current report, which consists of all of the sections in the file and anything else that you
have manually added to the report.
Print Current Section prints the properties, basic properties and diagram of the current section.

Options Menu
General Options... provides options for units and file locations.
View Options... provides for color choices as well as automatic refresh or recalculation.
Section Property Options... provides options for calculation of transformed section properties.
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Help Menu
Contents opens the help file so that you may search the contents and the index.
Send Email to RISA initiates an e-mail to RISA Technologies.
Go to RISA Web Site opens the default Internet browser to the RISA Technologies website.
About RISASection provides version and serial number information.

Shortcut Menu

The shortcut menu is also referred to as the Right-Click menu. This is because to access the shortcut menu you simply
click the RIGHT mouse button where you are working to see options that are relevant to what you are doing. For example if you right click in the workspace a menu will pop up and provide options to help you modify the section.
Perhaps the most important feature of this menu is that it is located wherever you RIGHT click the mouse. This way you
do not need to move away from where you are working to select the features you want to use.

Hot Keys
Hot Keys allow you to use the keyboard to quickly access the following features:

Key Combination

Function

CTRL + N
CTRL + O
CTRL + S
CTRL + P
CTRL + Z
CTRL + Y
CTRL + X
CTRL + C
CTRL + V
CTRL + A
F7
F8
F1

New Section File
Open Section File
Save Section File
Print Current Section
Undo
Redo
Cut
Copy
Paste
Select All
Calculate General Properties
Calculate Torsional J
Access Help Menu Contents

Toolbars
The available toolbar buttons are listed below. There are equivalent menu options available for almost all toolbar buttons. The options have been grouped into two toolbars (the RISA toolbar and the Window toolbar) from the point of
view of common and specific usage. The Window toolbar will affect only the current section in the workspace, but the
buttons on the RISA toolbar can be used for tasks common to all views, properties, windows, etc.

General Reference Manual
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RISA Toolbar
New

Creates a new Section file.

Open

Opens an existing Section file.

Save

Saves the current Section file.

Print CurPrints the current Section report.
rent
Add Section

Adds a new Section to the current file.

Rename
Section

Allows renaming of a Section.

Remove
Section

Removes selected Section from file.

Cut

The selected Shapes in the workspace will be cut by pressing this button and then
placed in the Clipboard.

Copy

The selected Shapes in the workspace are copied to the Clipboard. These copied Shapes
can be pasted using the Paste button.

Paste

The Shapes placed in the Clipboard using Copy button or Cut button will be pasted in
the workspace.

Delete

Deletes the selected part of the Section.

Undo

Undo previous action. This can be used to undo multiple previous actions.

Redo

Redo the previous Undo. This can be used to redo multiple previous actions.

Section
Props

Computes basic properties of the Section.

Torsion
Props

Computes the Torsional Constant (J) of the Section.

Report
Wizard

Opens the Report Creation Wizard.

Preview

Allows you to preview the current report.

Print
Report

Prints the current report for all of the Sections in the file.

Help

Opens the Help menu.

E-mail

Opens an E-mail to RISA Technologies. An Internet connection is needed for this
option.

Web Site

Opens the RISA Technologies web site. An Internet connection is needed for this
option.

About

Reports program info such as version number and copyright date.

Window Toolbar

14

Refresh

Refreshes all views and calculates the Section properties.

Edit Layout

Opens Edit Shape Layout to locate the shapes by specifying coordinates
and angles.

Shape Editor

Opens the Shape Editor Form for the current shape. The Shape Editor is
used to modify the dimensions and properties of the current shape.
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Toggle Dims

Toggles the display of overall dimensions of the Section in the Main Drawing Area.

Rotate
Group

This command will rotate the selected group of Shapes by the amount you
specify.

Rotate Right Rotates the selected Shape by 90 degrees in the clockwise direction.
Rotate Left

Rotates the selected Shape by 90 degrees in the counter-clockwise direction.

Flip Horizontal

Flips the selected shape about a vertical axis.

Flip Vertical Flips the selected shape about a horizontal axis.
Align Left

Aligns the selected Shapes on their left edge. The alignment is done with
respect to the least value of the x-coordinate of the first selected shape.

Align Center

Aligns the selected Shapes along the vertical centerline. The alignment is
done with respect to the x-centroid of the first selected shape.

Align Right

Aligns the selected Shapes on their right edge. The alignment is done with
respect to the highest value of the x-coordinate of the first selected shape.

Align Top

Aligns the selected Shapes on their top edge. The alignment is done with
respect to maximum value of the y-coordinate of first selected shape.

Align
Middle

Aligns the selected Shapes along the horizontal centerline. The alignment is
done with respect to the y-centroid of first selected shape.

Align Bottom

Aligns the selected Shapes along bottom edge. The alignment is done with
respect to the lowest value of the y-coordinate of the first selected shape.

Stack Vertically

Stacks the selected Shape vertically, one on top of the other. The x-coordinates are not changed.

Stack Horizontally

Stacks the selected Shape horizontally, side-by-side. The y-coordinates are
not changed.

Parallel
Align

Allows you to select a line in the currently selected shape and align it to
another (parallel) line of a different shape.

Show/Hide
Grid

Show/Hide the grid lines. This may be used to hide grid lines for a clear
view of the Shapes and the Sections in the workspace.

Modify
Grids

Opens the paper grid size dialog which allows you to modify grid size and
spacing.

Toggles the Snap to Grid option. If Snap to Grid is activated then all movements of the mouse are locked to the nearest grid. This includes drawing of
Snap to Grid shapes, moving shapes or resizing the shapes. For more precise control, you
may modify the grid sizes, switch off the Snap to Grid option or use Shape
Layout Editor.
Reset View

Resets the view. This will reset the view in such a way that the whole Section is visible with all shapes on the workspace.

Zoom In

This button will enlarge the view and you may then scroll using the horizontal and vertical scroll bars to any required view.

Zoom Out

This button will zoom out to see more of the section in the view.

Merge
Shapes

This will merge together all your individual shapes into one section.

Explode

This will explode previously merged shapes back to the original individual
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Shapes

shapes.

Add Current
Add the current view to the Main Report.
View

Rendered View Window Toolbar
Activate 3D
Switches from a section view to a rotating isometric three dimensional view.
View
Reset 3D
View

Resets the view. This will reset the view in such a way that the whole Section is visible with all shapes on the workspace.

Zoom In

This button will enlarge the view and you may then scroll using the horizontal and vertical scroll bars to any required view.

Zoom Out

This button will zoom out to see more of the section in the view.

Add Current
Add the current view to the Main Report.
View

Properties Window Toolbar
Copy

The selected Shapes in the workspace are copied to the Clipboard. These copied Shapes
can be pasted using the Paste button.

Add Current
Add the current view to the Main Report.
View

Database

At the far right side of the RISA Toolbar is the Database selection menu. This menu is only available if you have
selected the RISA HR Database tab from the Shape Library. The Database menu controls which Hot Rolled Steel shape
database (AISC, Canadian, Euro Shapes, etc.) is displayed in the RISA HR Database menu on the Shape Library.

Status Bar
The status bar passes useful information to you as you work. It is divided into three parts located along the bottom of the
main application window, just beneath the workspace.
The first box gives the number of sections that are in the file. Note that you can create multiple sections and save them
within a single file.
The second box gives the name of the shape that is currently shown in the workspace.
The last box on the status bar indicates the coordinates where the cursor is currently located.
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Shape Library
The shape library provides basic shapes that are used for building sections.
Located on the left side of the application, the library is divided into four categories: Basic Concrete Shapes, Basic Steel Shapes, RISA HR Database, and
Sections in Current File.
Basic Concrete Shapes: This tab contains concrete sections with different geometric shapes. These shapes may be modified by editing the dimensions in the
shape editor or by simply resizing with the mouse. The resizing with mouse
will modify the overall dimension of the section and proportionally change
the component dimensions.
Basic Steel Shapes: This tab contains general steel shapes that can be modified in the same way that Basic Concrete Shapes can be. It has been further
subdivided with vertical tabs on the left into the following three groups: hot
rolled shapes, cold formed shapes and built-up shapes.
RISA HR Database: This tab contains a database of Hot Rolled Steel
members that is taken from the designated Database. These shapes can not be
manipulated.
Sections in Current File: This tab contains the current sections that the user
has created in this file. Note that you can create multiple sections within one
file. You need to be careful with naming of your sections. See Section File
Names and Toolbars to get more information on this.

Workspace

The workspace is the main (center) portion of the application where
you actually build and edit your section. To do this, drag basic shapes
from the libraries on the left and then resize and reposition those
shapes to define the section. The main axes help to place shapes graphically. The shape editor assists you with the basic dimensioning of the
basic shapes that you add to the section from the libraries. The layout
editor gives exact coordinates and orientation for each shape for fine
adjustments. The layout grid with snapping, dimensions and layout
tools may be used to help you position shapes.

Workspace Options
The workspace grid may be turned on and off by clicking the

button on the Window Toolbar. Click

grid increments. Grid snapping may be turned on and off by clicking
and resizing of shapes is restricted to the nearest grid lines.

. When snapping is turned on the movement

Overall dimensions of the section may be turned on and off by clicking

.

Use

to reset to a full view.

and

to zoom the view of the workspace in and out. Click

to edit the

The colors used in the workspace may be adjusted in the View Options... under the Options menu.
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Rendered View
The rendered view is the upper right window that shows the rendered (solid) form of the section created in the workspace. This
view has its own toolbar. The colors used in the rendering may
be adjusted in the Optionsmenu.
Shapes are filled with appropriate color. The void in a predefined shape and in any shape assigned a negative shape multiplier is drawn in the background (or shown in opaque color in
the rendered view).
By default, different colors are used to draw and fill shapes of
different material or type. Separate colors are used for Concrete,
Hot Rolled and Cold Formed shapes. To change the colors used
in drawing these shapes, select View Options from the Options
menu. You can specify the border and fill colors for various
types of shapes as shown here.

Section Information
Just beneath the rendered view is the Section Information window. This window displays the basic information of the
selected section. This information includes:
File Name - This is the name of the RISASection file (.nmsx file). It cannot be edited from this window; if you'd like to
resave the file with a different name please select Save Section File As from the File menu.
Section Name - This is the name of the current Section. Since each RISASection file (.nmsx file) can contain multiple
Sections, this entry allows you to name them individually.
Material Type - This selection allows you the ability to assign a Material Type to your section in order to then select
an appropriate Shape Type (please see below). This information is only used for integration with RISA-3D and RISAFloor and will not effect the Property Multiplier information. Currently the only options are General and Hot Rolled
Steel. More Material Type options will be added to a future version of RISASection.
Shape Type - Depending on your Material Type selection (please see above), this menu changes to offer you material
specific shape types. This information is used in the integration with RISA-3D and controls which sections of the code
are used to perform code check calculations. Currently the only options are General (Arbitary) and Hot Rolled Steel
(Wide Flange, Channel, Tube, etc.) material shape types. More material and shape type options will be added to a future
version of RISASection.

Properties Window
The Properties window is located at the lower right portion of the screen. It shows the summary of the geometric properties of the current Section (the one displayed in the Workspace).
This window displays all of the calculated cross sectional shape properties for the current Section. These entries change
depending on the Material and Shape Type selected in the Section Information window. Please see the Section Properties topic for more information on the individual properties.
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The values above the solid black like are calculated per the actual geometry in the workspace. The values below the line
(except Torsional J) are approximate values based on the Flange Thick, Web Thick, Leg Thick values. Since RISASection cannot guarantee the calculation of these Thickness values, you can edit these and see how they change the
other torsional properties which are calculated using approximate formulas.
The only exception to this is the Torsional J value. Torsional J is always calculated using a finite element solution of the
actual geometry in the workspace. However, you can always edit this value if you choose.
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Building Sections
Basic Steps
To Build and Solve a Section
1. When you open the program, you are given a window that allows you to open an existing project, or, if you
close the window, you can begin a project from scratch. If you begin a project from scratch, you are ready to
begin building your section. Remember, RISASection allows you to build multiple sections within a single file
name. To add a new section to an existing file click
and click
to rename the section.
2. Choosing from the library of shapes on the left side of the application, double-click or drag-and-drop shapes from
the libraries to the workspace.
3. Resize the shapes in the shape editor once they are in the workspace by double-clicking the shape edge and entering the basic dimensions.
4. Reposition the shapes using the stacking and aligning tools or click
to use the Shape Layout Editor.
5. Click
6. Click

and

to calculate the properties if they aren't updating automatically.

to print the current section or click

to build a report.

Notes:
l

l

Alternatively you can import a shape from a DXF. Please see the DXF Import topic for more information on how
to import these shapes.
See the following sections to learn how to manipulate the shapes once you have added them to the section. It is
important to give unique, descriptive names to each section so that you can discern them for use in RISA-2D,
RISA-3D, and RISAFloor. Sections will be displayed by the Section name as well as the File name.

Selecting Shapes
After shape have been added to the workspace from the library you may select one or more to move and edit in order to
properly define the section.

Single Shapes

To select a single shape you may either click the edge of the shape or draw a box that contains only one entire shape
(the box may contain part of another shape). The selected shape will be shown as above (outlined with a dashed line
with sizing handles that may be used to stretch the shape).
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Multiple Shapes

To select multiple shapes you may either hold down the shift key while clicking on the individual shapes, or draw a box
that entirely contains the multiple shapes, as shown above. Shapes not entirely within the box will not be selected. The
selected shapes will be shown outlined with a dashed line.

Moving and Editing Shapes
There are a number of ways that you can edit the shapes after they are added from the Library to the Section. Some
actions may be performed on multiple shapes simultaneously by first selecting the desired shapes. Snapping may also be
used in conjunction with some of the methods to restrict stretching and moving to the nearest grid line. Grid snapping
may be turned on and off by clicking

.

Dragging Shapes
Dragging may be performed on individual shapes or selected multiple shapes by clicking and dragging the edge of a
shape.
Note: This may be easier if you turn off the Snap to Grid option. Simply click the Snap to Grid button
this option on and off.

to toggle

Stretching Shapes
Stretching (resizing) a single shape may be done by clicking the shapes edge to display resizing handles and then clicking and dragging the handles.
Note: You cannot stretch pre-defined shapes from one of the Hot Rolled Shape Databases or any merged shapes.

Rotating Shapes
The graphic editing rotate buttons are provided on the RISA Toolbar:

These buttons help you rotate and flip the selected shapes in the workspace.
Note: Because you can rotate a single shape, or a group of shapes, the rotate is always in reference to the centroid of the
selection rectangle, not necessarily the centroid of the selected shape.
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Aligning and Stacking Shapes
The graphic editing rotate buttons are provided on the RISA Toolbar:

The Alignment buttons
The Stacking buttons

help you align the sides or centers of selected shapes.
help you stack selected shapes on top of one another or side-by-side.

The Parallel Alignment button

helps you align shapes per their parallel edges.

Merge and Explode
The general properties will automatically update to include all shapes in the section. However, you may want to merge
the sections in order to get a more accurate Torsional J calculation. To do this, simply click the Merge button
you want to un-merge the shapes, simply click the Explode button

. If

.

Note:
l
l

Only shapes of the same material will merge.
Shapes with a Property Multiplier of -1 (designating a void) will not merge.

Cutting and Pasting Shapes
You may cut and paste single or multiple shapes by selecting the shapes and then clicking cut
.
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Shape Editor

Double-click the edge of the shape or select the shape and click
to open the Shape Editor. This editor may be used
to redefine the basic dimensions of the shape, shape label and modulus of elasticity.
The main part of the editor displays the shape and its dimensions. You can edit the dimensions by highlighting the
values and specifying new dimensions. You can show the modified shape by pressing the Refresh button. You can also
change the shape type by choosing from the toolbar on the top. The toolbar presents shapes from the same shape family
such as Basic Concrete Shapes and Basic Steel Shapes.
You may also edit the Shape Label and Modulus of Elasticity. The Property Multiplier is a ratio between the input
Modulus of Elasticity and the Modulus of Elasticity of Steel (29000 ksi).

Note
l

You may not edit shapes in the RISA HR Databases. To specify custom shapes, choose the shape from the Basic
Steel Shapes or Basic Concrete Shapes options in the Shape Library and edit the shape dimensions to define the
custom size.
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Shape Layout Editor

Click
to open the Shape Layout Editor.The Shape Layout Editor lists all shapes currently in the section and lets you
view and edit the Label, Multiplier and position of each shape. The editor is a spreadsheet with each shape listed on it's
own line and the columns are as follows:

Column Label

Description

Sh. No

Shape number (non-editable)

Shape Label

Description of the basic shape

Multiplier

Multiplier used for transformed section properties (1.0 implies the modulus of elasticity of steel)

Coord-X0

X-coordinate of the shape centroid

Coord-Y0

Y-coordinate of the shape centroid.

Angle

Rotation of the shape in the counter-clockwise direction.

Note: If your Section contains merged shapes, the Shape Layout Editor will by default only display the information pertaining to the overall (merged) Section. However, you can expand this to also show the properties of the individual
merged shapes.
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How to Use Shape Draw and Color Notation
All Shapes are drawn in true proportions on the screen as well as on the paper. The drawing area is automatically scaled
to fit the Shapes. To create extra space around the Section or Shape drawing, you can use the zoom down button.
Closed Shapes are filled with appropriate color in the Rendered view. The open Shapes are drawn as single lines, irrespective of the actual thickness of the plate or sheet.
By default, different colors are used to draw and fill Shapes of different material or type. Separate colors are used for Concrete, Hot Rolled and Cold Formed Shapes. To change the colors used in drawing these Shapes, use the View tab in the
Options menu. You can specify the border and fill colors for various types of Shapes. See View Options for more information.

Solving for Properties
RISASection calculates most properties, per flat plate theory, automatically as you edit the section. If you notice that editing is going slowly for a larger file you can turn off automatic calculation in the View tab of the Options menu to manually calculate.
The torsion constant J is not calculated automatically to allow for faster editing. To calculate the torsion constant click
.

Torsional J Calculation
The Torsional J value is calculated per a finite element integration method for any built-up or shape from one of the
Basic libraries. Please see Computation of Properties for more info on this calculation. If you select a shape from the
RISA HR Database, then RISASection will instead read in the J value directly from the database.
Unless you merge your shapes using the Merge tool, the Torsional J calculation will simply be a summation of the
individual shape's J values. Therefore it is recommended that you merge your Section for the most accurate results.
The other torsional properties (i.e. Cw, Sw, Wno, etc.) are calculated based on approximate formulas based on the Flange
and Web Thicknesses.

Editable Properties
RISASection uses approximate calculations to calculate the torsional properties Cw, Wno, Sw, Qw, and Qf for Hot
Rolled shapes. These approximate formulas depend on the editable properties below. Due to complex built up shapes,
there may be times where these are not quite accurate. Therefore, we recommend that you always verify these values
against your shape. If our simplified method does not capture the correct value, simply overwrite it in the Properties window. All the properties that are effected by these values are grouped beneath the solid black line, so you should be able
to quickly see the changes take effect.
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RISASection attempts to determine these values with the following methods:

Flange Thickness
The Flange Thickness value for Channel, Wide Flange, and W_Tee shapes is determined by taking 10 vertical cuts
through the entire section. RISASection then finds the smallest non-zero thickness and divides by two.
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Web Thickness
The Web Thickness value for Channel, Wide Flange, and W_Tee shapes is determined by taking a horizontal cut at the
mid-height of the entire section. The thickness at this location is taken as the web thickness.
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rT
rT is only available for Wide Flange sections that are assumed to be doubly symmetrical. This is taken as the radius of
gyration of the top flange plus one third of the web area, taken about the X axis. This calculation is done using the Web
and Flange Thicknesses defined above.

Leg Thickness
The Leg Thickness value for Single and Double Angles is determined by taking 10 vertical cuts across the width of the
entire section. RISASection then takes the smallest non-zero value as the Leg Thickness.
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Space
RISASection makes no attempt to determine the space between a Double Angle shape. Therefore, the automated value
for this will always be set to zero. You can override this by typing the appropriate value into the Properties window
directly.

Thickness
The Thickness value for Pipe and Tube shape types is determined by taking 10 horizontal cuts along the height of the
entire section. RISASection then takes the smallest value and divides by two for the Thickness.
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Total Width (Top) and Total Width (Bot)
The Total Width (Top) and Total Width (Bot) values for Tapered Wide Flange shapes are determined by taking 10 horizontal cuts along the height of the entire section. RISASection then takes the width at the top cut as the Total Width
(Top) value and the width at the bottom cut as the Total Width (Bot) value.
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Flange Thick (Top) and Flange Thick (Bot)
The Flange Thick (Top) and Flange Thick (Bot) values for Tapered Wide Flange shapes will always be equal, unless the
user overwrites them with manually entered values. RISASection determines the Auto value by taking 10 vertical cuts
along the width of the entire section. Then, it takes the smallest non-zero thickness value and divides by two for the
Flange Thick (Top) and Flange Thick (Bot) values.
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DXF Import
DXF Import Procedure
To Import a DXF Section
1. Draw the outline of the section in your CAD program. If you have multiple shapes defined in one DXF file, we
recommend that you place them on separate layers in your CAD program.
2. Save the file as a DXF file.
3. Open RISASection (you can open a new file or an existing file).
4. Go to File - Import DXF File and browse to select your DXF file.

Notes:
l
l

l
l

RISASection will only import 2D shapes from your CAD model.
It is recommended that you separate any built up sections onto separate layers in the DXF file. For instance, if
you are modeling a cap channel, you should model the wide flange shape on one layer and the channel on
another. This helps the import function to clearly separate the shared lines between the two for a more accurate
import.
The program will warn you if your DXF, or part of your DXF cannot be imported.
The program will always import a DXF section as a New Section in your file. Therefore, if you want to add
shapes to it within the program you must import first and then add shapes later.

For additional advice on this topic, please see the RISA News website: www.risanews.com. Type in Search keywords:
DXF Import.

Import DXF Options
After selecting your DXF file, the program will offer you options for the import in the Import DXF File dialog so that
you insure an accurate import.

The options are as follows:

DXF Units
This selection allows you to define which units you used in the CAD model. Therefore, if your CAD model was created
using millimeters and the RISASection file defaults to inches, the import feature will automatically convert the
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dimensions.
In addition to the standard unit options, you may also chose None as your DXF Units. This simply means that no unit
conversion will be taken into account. The dimension magnitudes that you entered in CAD will be taken as they are for
the RISASection model. These magnitudes will then be assigned units based on the default units set in RISASection.

CAD Plane
This selection defines which plane you drew your two dimensional section in the CAD model.

CAD Vertical Axis
The implied default vertical axis in AutoCAD is the positive Z-axis of the current User Coordinate System. The default
vertical axis in RISASection is the positive Y-axis. Therefore, when you import your model from a DXF file, you can
have the program automatically rotate your geometry so that the Y axis is now the vertical axis for your RISASection
model.

Invalid DXF Shapes
RISASection will not import the following shapes from DXF:
l
l
l
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Single line segments
Open outlines (such as a U shape)
Spline line types
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Options
You can edit the program options by using the Options menu.

General Options

Dimension Units
You may adjust the units at any time by selecting the units system from the drop down list.
You can work with imperial (inches, feet, etc.) or metric (centimeters, millimeters, etc.) units. You may also change units
at any time and RISASection will automatically perform the conversion.

RISA Database
The RISA Database designates where your RISASection files are being read from and written to. The Hot Rolled Steel
database files (AISC, Canadian, Euro Shapes, etc.) are read in from this location, and any RISASection file that you save
will by default, save to this location.
It is a good idea to keep this as the C:\RISA folder since this is the default location for the RISA-2D, RISA-3D, and
RISAFloor programs to look when they are reading in RISASection shape files.

Merge Tolerance
This distance controls how close two shapes have to be to one another in order to be merged together using the Merge
tool.

Startup Checkboxes
The other two checkboxes refer to startup options.
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View Options

Colors
Change the Border colors to change the colors used in the workspace and the Filling colors to change the rendered
view. Simply click on the color that you want to change and you will be offered a palette from which to chose your new
color.

Views
By default the views update automatically. If you disable automatic features, then the Rendered window and the Properties window will not update until you click the solve button.

36

RISASection V2.0

Options

Section Property Options

To compute transformed section properties for sections that contain different materials you may specify the Base Modulus of Elasticity. This value represents the property for the base material and other materials will be converted to align
with the base value. Here you can also define default values for concrete or steel. Note that when creating shapes you
can always manually modify this value as well. If you don't want the program to consider differences in stiffnesses for different materials, you can select Don't consider Modulus of Elasticity. For more information on stiffnesses and property
multipliers, see Property Multiplier.
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Preparing Report and Printing
You may print one section at a time or print a report that contains multiple sections.

l

To
To
To
To

l

To print a report that has already been created click Print Current Report

l
l
l

print the properties and a diagram of the current section click the Print Current Section button
create a report, activate the Report Wizard by clicking
.
add a view to a report click
.
preview a report that has already been created click Preview Current Report .

.

.

Report Creation Wizard
As the name indicates it helps us to prepare the report in a systematic way. It may be opened by the Report Creation
Wizard button
or by selecting Report Creation Wizard from the Results menu. As shown in the following screen
capture, different check boxes are provided to select the items of interest. These items are divided into two groups. Once
the required items have been added/selected we can press the Generate Report button to finish the report generation
process.

Main Report Itemsare listed on the left side of the Report Creation Wizard.

Main Report Items

Description

Project Information

Includes the project information at the top of the report.

Calculation Procedure

Includes the calculation procedure at the beginning of the report.

Sections in Current File

Includes the items selected in the right pane (see below) for each section in the current
file.

Re-compute Torsional Constant

Will re-compute the torsional constant again at the time of report generation.

Section Items are listed on the right side of the Report Creation Wizard.
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Section Items
Section Properties

Description
Includes the calculated properties for each section.

Section Diagram Includes the diagram for each section.
Properties of
Shapes

Includes the properties for the basic shapes in each section.

Summary of All At the end of the report this summarizes each section in one line that includes the name, width,
Sections
height, centroid, area and inertias for each section.
Section Rendered View

Includes a graphic image of the Rendered View.

Main Section
view

Includes a graphic image of the main Section view (what is visible in the Workspace).

Previewing Current Report
To preview a report that has already been created click
. Once the preview is open you can adjust the view and print
the report. The toolbar along the top provides options to print, move page by page or jump to the start and end of the
report and zoom in and out. You may also close the report without printing. The same options are available on the small
toolbar along the bottom left of the preview.

Add Current View to Report
To add the current view in the report it may be done by the clicking
or by selecting Add to Report from the Section
menu. The added view then can be viewed and printed by the Report Manager.

Print Current Report
Any graphic view, currently being displayed on any port, can be sent for printing by clicking
located on a toolbar
appearing at the top of the respective view port. This is useful for quick printing of the current view without having to
go through the Report Manager/ Wizard. The current view can be added to the report by pressing Add Current View to
the Report

button, which can be customized and printed later.
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These examples are designed to teach you about the features that are available so that you may then build any shape that
you need. The process is similar for all sections you will use basic shapes from the library to describe each section. The
shapes will be taken from the library and placed in the workspace. You will then rotate, align and stack the shapes to
configure the section. This process will be repeated for each section that you want to describe in the file and then you
will simply print a report and save the file.
Because each file can contain multiple sections, you will also learn how to rename sections and designate them with
Material and Shape Type for import into RISA-2D, RISA-3D, or RISAFloor.

Built-Up Shapes Examples
In this example we will define two steel sections in one file. The first will be a tapered wide flange, and the second will
be a wide flange with a cap channel.

Tapered Wide Flange Example
Note - You may click the Undo button at any time to correct mistakes.
1. Start RISASection by clicking the shortcut on your desktop or selecting it from the Windows Start
menu. RISASection will open a new file and present you with the Starting a Model dialog.

2. This dialog allows you to quickly access previous files. However, you will be starting a fresh model in
this example, so click Close to close the dialog.
3. Click the Rename Section button
click OK.

from the RISA Toolbar. Type in "Tapered Wide Flange" and

4. On the left side of the application, under Shape Library, click Basic Steel Shapes. Double-click the
Tee Section shape it will be added to the workspace.

40

RISASection V2.0

Examples

5. Edit the shape properties in the Shape Editor. To open the Shape Editor, double-click the edge of the
shape that is now in the workspace.

6. Change the flange width by clicking in the top dimension box and type "12". Repeat to change the
flange thickness to 1", the depth to 11" and the web thickness to 0.75".Click OK to close the editor.
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7. Next, double-click the Solid Rectangular shape from the Basic Steel Shapes Library to add it to your
section.
8. Double click the edge of the Solid Rectangular shape to open the Shape Editor. Change the width to
8" and the depth to 0.75". Click OK to close the editor.
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9. Next, you will move the shapes into the appropriate locations. In RISASection, you can always drag
and drop sections manually, but for this example, you will use the Alignment and Stack tools to move the
bottom flange.

Start by selecting both shapes: click on Select All from the Edit menu.

10. Click the Align Bottom button

first.

11. Next, click on the Stack Shapes Vertically button

.

12. The next step is to assign the section the appropriate Material and Shape Types for integration with
RISA-2D, RISA-3D, or RISAFloor.
In the Section Information window, select Hot Rolled Steel from the Material Type drop down menu.
Then, select Tapered WF from the Shape Type menu.

13. Click the Merge button
to merge together the two shapes into a single shape. This will ensure
that you get the most accurate Torsional J calculation.
14. Click the Solve button

and the Torsional J Solve button

to update the results.

15. Finally, save the file by selecting Save Section File from the File menu. Continue with the next example to learn how to add multiple sections to one file.
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Cap Channel Example
1. Continuing from the previous example, you will now add a new section to the existing file. Click the
Add New Section button
blank workspace.

from the RISA Toolbar. This will automatically open a new section with a

2. Under the Shape Library, click on RISA HR Database.

3. Make sure that the Database selection (on the Window toolbar) is set to AISC.

4. In the database on the left, double-click W14X30 in order to add it to your workspace. Since this is a
shape taken directly from the program databases, the dimensions are all preset and so you do not need to
modify anything.

5. Next, click on the Channel tab

and double-click on the C12X20.7 to add it to the section.

6. Click on the edge of the channel section to select it.
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7. Click the Rotate Right button

to flip the channel 90 degrees.

8. Click CTRL + A on your keyboard to select all shapes.

9. Select the Align Center button
. Notice that this snaps the vertical axis of the wide flange to the centroid location of the channel. This is a bit off from the origin, so next, you will manually move these back.
10. Select Shape Layout from the Section menu. This will open the Shape Layout Editor.
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11. Make sure that the Coord-Y0 value of both Shape Number 1 (W14X30) and Shape Number 2
(C12x20.7) to 0. Click OK to close the dialog and make the changes.
12. Next, click on the channel, so just that one shape is selected. Click the Parallel Align button
on
the Window Toolbar. Then, click on the inside edge of the channel web. Last, click on the upper edge of
the top flange on the wide flange shape.

13. This will move the channel shape up so that it is now sitting on top of the wide flange.
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14. Finally, rename the section by clicking the Rename Current Section button
“Cap Channel”.

and then typing in

Since this shape does not fall within one of the predefined Hot Rolled Steel Shape Types, leave it designated as a General Material, Arbitrary Shape.

Multi-Material Shapes Examples
These example explore building shapes with multiple materials.

Composite Beam Example
Note - You may click the Undo button at any time to correct mistakes.
1. Start RISASection and open a new file.
2. Click Close to close the Starting a Model dialog.
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3. Click the Rename Section button
OK.

from the RISA Toolbar. Type in "Composite Beam" and click

4. Under the Shape Library, click on RISA HR Database.

5. Make sure that the Database selection (on the Window toolbar) is set to AISC.

6. In the database on the left, double-click W36X150 in order to add it to your workspace. Since this is a
shape taken directly from the program databases, the dimensions are all preset and so you do not need to
modify anything.

7. Next, click on the Basic Concrete Shapes Library. Double-click on the Rectangular shape to add it to
your section.
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8. Double click the edge of the Rectangular shape to open the Shape Editor. Change the width to 36"
and the depth to 4". Click OK to close the editor.
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9. Next, you will move the shapes into the appropriate locations. In RISASection, you can always drag
and drop sections manually or use the Alignment and Stack tools, but for this example you will manually
adjust the centroid location in the Shape Layout Editor.
Select Shape Layout from the Section menu. This will open the Shape Layout Editor.

Notice that the Rectangular shape has a Multiplier of 0.108828. This is because you selected it from the
Basic Concrete Shapes library. This means that the Rectangular shape has a Modulus of Elasticity equal
to 0.108828 x 29000 ksi = 3156 ksi.
10. Change the Coord-Y0 value of Shape Number 2 (Rectangular) to 22.925. Click OK to close the
dialog and make the changes.
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11. Click the Reset View button

to see the full section.

12. Next, define the Material and Shape Type in the Section Information window.
Since this shape does not fall within one of the predefined Hot Rolled Steel Shape Types, leave it designated as a General Material, Arbitrary Shape.

13. Click the Solve button

and the Torsional J Solve button

to update the results.

14. Finally, save the file by selecting Save Section File from the File menu. Continue with the next example to add another section to the file.

Cracked Section Example
1. Continuing from the previous example, you will now add a new section to the existing file. Click the
Add New Section button
blank workspace.

from the RISA Toolbar. This will automatically open a new section with a

2. Under the Shape Library, click on Basic Concrete Shapes.
3. Double-click Rectangular to add it to your workspace.

4. Double click the edge of the Rectangular shape to open the Shape Editor. Change the width to 10" and
the depth to 5.58". Click OK to close the editor.
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5. Next, click on the Basic Steel Shapes database under Shape Library.

6. Double-click on the Solid Bar shape to add it to your section.
7. Double click the edge of the Solid Bar shape to open the Shape Editor. Change the diameter to 0.79".
Click OK to close the editor.
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8. Next, move the Solid Bar down to the correct location. Open the Shape Layout Editor
the Y0 coordinate of Shape No. 2 (XSHRBar) to -17.21.

General Reference Manual

and change

53

Examples

Click OK to close the editor.
9. Next, you will copy the Solid Bar shape twice to add the remaining shapes. Select the Solid Bar shape
by clicking on its edge.

10. Use the right-click menu to first Copy the selection and then Paste it twice.
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11. Reopen the Shape Layout Editor and change the coordinates of the two new bars to match the following:

12. Finally, rename the section by typing “Cracked Section” into the Section Name entry in the Section
Information window.

Since this shape does not fall within one of the predefined Hot Rolled Steel Shape Types, leave it designated as a General Material, Arbitrary Shape.
13. Save the file by clicking on the Save Section File button
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Technical Support
Technical support is an important part of the RISASection package. There is no charge for technical support for all
licensed owners of the current version of RISASection. Technical support is very important to the staff at RISA Technologies. We want our users to be able to reach us when they are having difficulties with the program. However, this
service is not to be used as a way to avoid learning the program or learning how to perform structural modeling in general.
Hours: 6AM to 5PM Pacific Standard Time, Monday through Friday
Before contacting technical support, you should typically do the following:
1. Please search the Help File or General Reference Manual. Most questions asked about RISASection are already
answered in the Help File or General Reference Manual. Use the table of contents or index to find specific topics
and appropriate sections. We go to great lengths to provide extensive written and on-line documentation for the
program. We do this in order to help you understand the features and make them easier to use. Also be sure to go
through the entire General Reference Manual when you first get the program.
2. If you have access to the Internet, you can visit our website at www.risa.com and check out our Support page for
release notes, updates, downloads, and frequently asked questions. We list known issues and product updates that
you can download. So, if you think the program is in error you should see if the problem is listed and make sure
you have the latest release. The FAQ (Frequently Asked Questions) section may also address your question.
3. Make sure you understand the problem, and make sure your question is related to the program or structural modeling. Technical Support does not include free engineering consulting. RISA Technologies does provide a consulting service. If you are interested in inquiring about this service, please call RISA Technologies.
4. Take a few minutes to experiment with the problem to try to understand and solve it.
For all modeling support questions, please be prepared to send us your model input file via email or postal mail. We
often will need to have your model in hand to debug a problem or answer your questions.
Email: support@risatech.com: This method is the best way to send us a model you would like help with. Most
email packages support the attachment of files. The input file you would send will have a .nmsx extension. Make sure
you tell us your name, company name, serial number or Key ID, phone number, and give a decent problem description.
Phone Support:(949) 951-5815: Feel free to call, especially if you need a quick answer and your question is not model
specific and therefore doesn't require us to look at your file.

56

RISASection V2.0

Index

Index
A

DXF Units 33

Add Current View to Report 39

E

Additional Calculated Properties 8

Edit menu 12

Aligning and Stacking Shapes 22

Editable Properties 25

Application Interface 11

Editing Shapes 21

Auto 9

Email (support) 56

B

Examples 40

Base Modulus of Elasticity 37

F

Basic Steps 20

File Menu 11

Build a Section 20
Built-up Sections 7

G

Built-Up Shapes Example 40

General Options 35

C

H

CAD Plane 34

Hardware Requirements 1

CAD Vertical Axis 34

Help 13

Calculated Properties 8

Hot Keys 13

Cap Channel Example 44

I

Closed Shapes 6
Color Notation 25

Import DXF Options 33

Colors 36

Installation 3

Composite Sections 7

Interaction with RISA3-D and 2-D 4

Computation of Properties 6

Interface 11

Cracked Section Example 51

Invalid DXF Shapes 34

Cutting and Pasting Shapes 22

L

D

Library 17

Database 16

License Agreement 1

Dragging Shapes 21

M

DXF Import 33
DXF Procedure 33

General Reference Manual

Main Menu 11

i

Index

Manuals 1
Merge and Explode 22
Merge Tolerance 35

Rotating Shapes 21

S

Moving and Editing Shapes 21

Saving 11

Multi-Material Shapes Examples 47

Section 12
Section File Names 4

N
Notations 4

O

Section Information 18
Section Properties 7
Section Property Options 37
Selecting Shapes 20

Options 12, 35

Shape Editor 23

Overview 4

Shape Layout Editor 24

P

Shape Library 17
Shortcut 13

Phone (support) 56
Plastic Modulus 6
Polygon Method 6
Preparing Report 38
Previewing Current Report 39
Print Current Report 39

Solving 25
Sorting 12
Startup Checkboxes 35
Status Bar 16
Stiffness Defaults 37
Stretching Shapes 21

Printing 38
Project Information 11

T

Properties 18

Tapered Wide Flange 40

Properties Window 18

Technical Support 56

Property Multiplier 7

Terms 4

R

Thin Walled Open Shapes 6
Title Bar 11

Rendered 18
Report Creation Wizard 38
Report Main Items 38
Report Section Items 39

Toolbars 13
Torsion Constant J 6
Torsional J Calculation 25
Tutorial 1

Results 12
RISA-2D 4

U

RISA-3D 4

Undo 12

RISA Database 35

Units 35

RISAFloor 4

ii

RISASection V2.0

Index

V
View Options 36
Views 36

W
Workspace 17

General Reference Manual

iii

